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CHAPTER 7
AN INTRODUCTION TO WINDOWS XP

Multiple Choice Questions And Answers
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Windows XP Professional is a __________operating system
a) single-user
b) user-friendly
c) user-dependent d) user-independent
Which of the following is a user-friendly operating system?
a) UNIX
b) LINUX
c) DOS
d) Windows XP
The most important advantage of using Windows is its ___________
a) GAI
b) GUI
c) IUG
d) GUA
GUI is pronounced as ______
a) GOOYEE
b) GOOUI
c) GOYI
d) GAI
Right side brain is good in processing the _______
a) numbers
b) letters
c) drawings
d) pictures
Before the introduction of GUI, users of OS, mainly used their _______brain.
a) left side
b) right side
c) front side
d) back side
_________ operating system uses Command Line Interface(CLI)
a) Mac
b) MS-DOS
c) Windows
d) both b and c
Windows XP Professional combines all the positive aspects of its ________predecessors.
a) Microsoft
b) Apple
c) IBM
d) Sun Micro
The _____ introduced the concept of Windows.
a) Sun Micro
b) IBM
c) Microsoft
d) Apple
______ popularised the Windows concept.
a) Sun Micro
b) IBM
c) Microsoft
d) Apple
The first version of Windows is______.
a) Windows 3.1
b) Windows 4.0
c) Windows 3.0
d) Windows 4.1
Windows 3.0 was followed by _______
a) Windows 3.1
b) Windows 4.0
c) Windows 3.0
d) Windows 3.11
Windows 3.1 used a window called _________to launch applications
a) Process Manager b) Task Manager c) GUI Manager
d) Program Manager
Microsoft introduced ________ for workgroups.
a) Windows 3.1
b) Windows 4.0
c) Windows 3.0
d) Windows 3.11
_________was a complete operating system.
a) Windows 3.0
b) Windows 3.1
c) Windows 95
d) Windows 91
________ operating system is independent of 9x(95 or 98)
a) Windows NI
b) Windows 3.1
c) Windows 3.0
d) Windows NT
In Windows NT, NT means ________
a) New Terminal
b) New Task
c) New Technology d) Next Technology
Windows Me stands for ________
a) Windows Meeting
b) Windows Millennium
c) Windows Make me
d) Windows Maximum
_________professional is designed to satisfy the insatiable demand of the business
a) Windows 95
b) Windows XP
c) Windows 98
d) Windows NT
________is an input device that you move on a flat surface
a) joystick
b) keyboard
c) mouse
d) scanner
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21. When you move the mouse, a pointer moves on the screen is called ________
a) Mouse Pointer
b) insertion pointer c) cursor
d) arrow pointer
22. The mouse has either ____ or _______ buttons on the top.
a) 3 or 4
b) 2 or 3
c) 1 or 2
d) 1 or 3
23. _____the mouse is simply dragging the mouse on the mouse pad.
a) pressing
b) dragging
c) moving
d) clicking
24. _______is used to select objects on the Windows screen
a) pressing
b) dragging
c) moving
d) clicking
25. _______ is most often used to start applications.
a) pressing
b) double-click
c) moving
d) clicking
26. _______ mouse action is used to move an object from one place to another.
a) click and drag
b) double-click
c) moving
d) clicking
27. When you click and drag an object, the object moves along with the _______
a) screen
b) background
c) text pointer
d) mouse pointer
28. If you right click on an item, you will be provided with a ________menu.
a) windows
b) context sensitive c) help
d ) multiple
29. Context sensitive menu is also called _________menu
a) help
b) windows
c) short-cut
d) keyboard
30. The context sensitive menu provides almost all the facilities offered by____ as well as ______.
a) menu, edit
b) menu, toolbars c) short cut, edit
d) either a or c
31. To move the mouse pointer by using the keyboard, make sure that _______ is turned on.
a) Num Lock
b) Caps Lock
c) Tab Lock
d) Key Lock
32. Equivalent key in the keypad for the mouse action double-click is___________
a) /
b) 5
c) +
d) 33. _____ is the equivalent key in the keypad of the keyboard for the mouse action of click
a) /
b) 5
c) +
d) 34. Use _______Keys when Num Lock is on.
a) Function
b) Number
c) Mouse
d) Alphabet
35. The key equivalent to lock the selected button is _____.
a) insert
b) delete
c) +
d) *
36. _________key is pressed to select both mouse buttons
a) insert
b) delete
c) +
d) *
37. Press the ______ key to select the left mouse button.
a) slash
b) plus
c) minus
d) 5
38. Press _______ key to release the button and drop the object.
a) slash
b) insert
c) delete
d) plus
39. If we turn off Num Lock, we can use the regular _____ keys.
a) Function
b) Number
c) arrow
d) Alphabet
40. The aim of logging in is to take you to Windows XP _____
a)desktop
b) screen
c) computer
d) window
41. We can select our account by clicking the appropriate icon or_______.
a) application
b) password
c) username
d) picture
42. ______ is a small picture / image representing an application
a) textbox
b) button
c) pointer
d) icon
43. _________is the process of closing the desktop and returning to the Windows Log In screen.
a) Logging off
b) Log in
c) Turn off
d) Restart
44. Keyboard Short cut for Start button is __________
a) Ctrl +Alt
b) Ctrl +C
c) Alt +Esc
d) Ctrl +Esc
45. ____ or ____ key is pressed to Turn off the Computer
a) T or t
b) U or u
c) L or l
d) S or s
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46. If we want to shut down the computer click _______button
a) Exit
b) Turn Off
c) Log off
d) Close
47. We can also Turn Off the computer by the key combinations of _________
a) Shift+F4
b) Alt+F3
c) Alt+F4
d) Ctrl+F4
48. If we want to switch over to the other operating system then click _______button.
a) Restart
b)Next
c) Log in
d) Start
49. When we switch on the computer, Windows XP automatically starts loading from the ______
a) CD
b) Hard disk
c) Memory
d) Desktop
50. The opening screen of Windows XP is called_________.
a) Dialog box
b) Window
c) Desktop
d) Task bar
51. Computers that are not connected to any other computers are called _____ computers.
a) Stand-alone
b) Personal
c) Home
d) Terminal
52. __________ basic working platform of Windows XP.
a) CPU
b) Windows
c) Desktop
d) Program
53. The _____is usually a narrow strip, present at the bottom of the screen.
a) Status bar
b) Menu bar
c) Tool bar
d) Task bar
54. On the left of the Task bar, it has the ____button.
a) OK
b) Start
c) Login
d) Cancel
55. When we click on the Start button, the _______menu appears on the left side of the screen.
a) View
b) Edit
c) Start
d) File
56. Using the ______menu, we can start any application that we have currently installed.
a) View
b) Edit
c) Start
d) File
57. Next to the Start button is the ________Toolbar.
a) Formatting
b) Task
c) Launch
d) Quick Launch
58. Through the ______toolbar which contains icons that allow you to select some commonly used
Internet-related applications.
a) Formatting
b) Task
c) Launch
d) Quick Launch
59. On the extreme right of the Task bar is the _________
a) Start button
b) Start menu
c) Systems Tray d) Quick Launch Toolbar
60. The empty space between the ______Toolbar and the ______is used to display buttons for the
applications currently being used.
a) Start, System Tray
b) Quick Launch, Systems Tray
c) Quick Launch, Start button
d) Task, Start button
61. The clock is displayed on the __________
a) Start button
b) Start menu
c) Systems Tray d) Quick Launch Toolbar
62. The _______acts as a launch pad for most of the things we want to do with Windows XP..
a) Start menu
b) Task bar
c) Systems Tray
d) Desktop
63. The _______on the taskbar is used to change the date and time.
a) button
b) Clock
c) Systems Tray
d) Calendar
64. When we start an application, it occupies a rectangular area on the desktop called _______
a) window
b) dialog box
c) Text box
d) background
65. To start WordPad, click on _______
a) Start All ProgramsAccessoriesWordPad
b) Start All ProgramsControl PanelWordPad
c) Start Windows Explorer AccessoriesWordPad
d) Start AccessoriesAll ProgramsWordPad
66. At the top of each window is the _______.
a) Menu Bar
b) Tool Bar
c) Title Bar
d) Task Bar
67. Below the Title Bar is the ___________.
a) Menu Bar
b) Tool Bar
c) Status Bar
d) Task Bar
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68. One or more __________appear below the menu bar
a) Title Bars
b) Tool Bars
c) Status Bars
d) Task Bars
69. ______ consist of icons representing shortcuts for the most frequently used commands.
a) Menu Bar
b) Tool Bar
c) Title Bar
d) Task Bar
70. _______ is the short cut key to save a file
a) Ctrl +X
b) Ctrl +C
c) Ctrl +S
d) Ctrl +F
71. We cannot drag a Window when it is either ______ or minimized.
a) restored
b) closed
c) moved
d) maximized
72. Every window has a _________that can be used to change its size.
a) Title Bar
b) Border
c) Outline
d) Dialog box
73. Windows XP is an __________operating system
a) intra-active
b) user-active
c) inter-active
d) extra-active
74. __________are used to allow the user to enter some data
a) Text boxes
b) Dialog boxes
c) Text areas
d) windows
75. ________ boxes display a list of choices.
a) Text
b) Dialog
c) List
d) menu
76. Every text box is accompanied by a _______ that tells you what should be entered in that box.
a) prompt
b) label
c) menu
d) either a or b
_______list boxes which have a small black inverted triangle at one end.
a) Pop-up
b) Drop-down
c) Drop-menu
d) Drop-up
77. _______buttons are used to display multiple options where we can select only one of the buttons
a) Check
b) Click
c) Radio
d) Choice
78. ______ boxes are used to enable or disable options.
a) Check
b) List
c) Radio
d) Choice
79. A tick mark in the_______ square indicates that the option is enabled
a) Text box
b) Check box
c) Radio button
d) Option button
80. We can select any number of _______boxes in the given option
a) Check
b) Click
c) Radio
d) List
81. The _____ and_____ buttons are the most frequently used buttons in Windows XP
a) OK, Ignore
b) OK, Click
c) OK, Cancel
d) Yes, Cancel
82. Clicking on _______ button will make Windows ignore the changes
a) Cancel
b) OK
c) Ignore
d) No
83. ______ are used to display different sets of options in dialog boxes.
a) List boxes
b) Tabs
c) Radio buttons
d) Check boxes
84. __________are used to enter a value by physically moving a marker over a slide
a) Pointers
b) Text boxes
c) Scroll
d) Sliders
85. The Microsoft provides lot of help in its ___________in Windows XP
a) Help and Share Center
b) Help Center
c) Help and Support Center
d) Support Center
86. _____ key will provide the help relevant to the program
a) F2
b) F5
c) F7
d) F1
87. There is no ______ in Help and Support Center window.
a) Menu Bar
b) Tool Bar
c) Title Bar
d) Task Bar
88. If we pick a topic from the _________ that will take us either to Remote Assistance or to
Support and Windows XP news groups.
a) Pick a Task
b) Help Center
c) Pick a Help Topic d) Ask for Assistance
89. If we click the ________ underline text, it will open the item associated with the text.
a) black
b) blue
c) green
d) red
90. If we click on ____ underlined term it will provide the definition of the term.
a) black
b) blue
c) green
d) red
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91. _________ is the first button in the navigation bar from left
a) history
b) back
c) home
d) forward
92. ______ button will take us to the previous page in Help.
a) history
b) back
c) home
d) forward
93. ______button is disabled in the beginning.
a) history
b) back
c) forward
d) both b and c
94. _______is the third button from left in the navigation bar.
a) history
b) back
c) home
d) forward
95. ________stores a list of help pages we have visited recently, in the left pane.
a) history
b) back
c) home
d) forward
96. The Taskbar is usually at the _________ of the desktop
a) top
b) left side
c) right side
d) bottom
97. We can arrange the windows with _____ ways.
a) 2
b) 3
c) 4
d) many
98. We can move a window by clicking and dragging the ________ of the window
a) Menu bar
b) button
c) title bar
d) borders
99. Show the Desktop is a substitute for _________button.
a) Show Desktop
b) Show Window c) Show Task
d) Show Icon
100. Click on ______ , we will be shown Taskbar and Start Menu Properties.
a) Start
b) Properties
c) Menu
d) Desktop
101. _______are constantly moving images that appears when the computer has been idle for some
time.
a) Wallpapers
b) Pictures
c) 3D Text
d) Screen savers
102. Screen Saver tab is available in the __________dialog box.
a) Picture
b) Properties
c) Display
d) Display Properties
103. _______ dialog box is used to change the wallpaper, screen savers, etc
a) Picture
b) Properties
c) Display
d) Display Properties
104. ______allows us to install and manage the different hardware components attached to our
computer
a) Windows
b) Drive
c) Desktop
d) Control Panel
105. To open the Control Panel window, click ________
a) Control Panel  Start
b) Start  Control Panel
c) Edit  Control Panel
d) File  Control Panel
106. The default view Control Panel window is ________View
a) Icon
b) Classic
c) Category
d) List
107. ________ icon in Control panel allows to adjust your computer settings for vision, hearing and
mobility deficiency
a) Properties
b) Fonts
c) Display
d) Accessibility Options
108. All information in Windows is stored as __________
a) Icons
b) Folders
c) Files
d) data
109. Files in Windows are broadly classified into _______categories.
a) two
b) three
c) four
d) many
110. Application files are also called as _________ files
a) Data
b) System
c) Information
d) Program
111. _________are used to create data files.
a) Folders
b) Applications
c) Information
d) Program
112. __________files are files that are created by the user using an application.
a) Data
b) System
c) Document
d) Program
113. We can start an application by clicking on its ______ on the desktop or by using the _____ menu.
a) Icon, Start
b) Start, Icon
c) Icon, Task
d) Start, Task
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114. A button representing the application also appears on the _______
a) Status bar
b) Tool bar
c) Task bar
d) Title bar
115. MS-DOS stands for ________________________
a) Microsoft Data Operating System
b) Microsoft Disk Operation System
c) Microsoft Data Operation Systems
d) Microsoft Disk Operating System
116. To use any DOS Command, _________option of windows can be used.
a) Run
b) Start
c) GUI
d) Command Prompt
117. To open MS-DOS Command Prompt Window, select __________
a) StartAll ProgramsAccessoriesCommand Prompt
b) StartAccessoriesCommand Prompt
c) Start AccessoriesAll Programs Command Prompt
d) All Programs StartAccessoriesCommand Prompt
118. Windows has an in-built clock, which is usually displayed on the _______
a) Status bar
b) Tool bar
c) Task bar
d) Title bar
119. ________ can be used to perform mathematical and scientific calculations.
a) Data
b) Calculator
c) Computer
d) Program
120. To start the Calculator, select ________
a) StartAll ProgramsAccessoriesCommand Prompt
b) Start All ProgramsAccessoriesCalculator
c) Start Accessories Calculator
d) Start AccessoriesAll Programs Calculator
121. The two modes of Calculator are ________ and ________
a) Standard, Normal
b) System, Scientific
c) Normal, Scientific
d) Standard, Scientific
122. ______ menu is clicked to use the Calculator in the Scientific mode.
a) File
b) View
c) Edit
d) Window
123. ________is an application that lets you draw and color pictures.
a) Drawing
b) Icon
c) Wordpad
d) Paint
124. You can color the pictures using the _________ in Paint.
a) Palette
b) Color Box
c) Color Bar
d) Air Brush
125. ________is a simple word processor that comes along with Windows.
a) MS-DOs
b) Button
c) WordPad
d) Paint
126. A small vertical blinking line appears at the work area is ________
a) Pixel
b) cursor
c) Line
d) Mouse Pointer
127. _____indicates your current position on the screen.
a) Pixel
b) cursor
c) Line
d) Pointer
128. ________key on the keyboard is used to start a new paragraph.
a) Space
b) Ctrl
c) Enter
d) Delete
129. If you want to set the margin that can be done with ________of the File menu
a) Page Setup
b) Page Preview
c) Setup
d) Page
130. _______ key is pressed to move the cursor to the beginning of the line.
a) Ctrl+Home
b) Home
c) Alt+Home
d) Start
131. _______ key is pressed to move the cursor to the end of line.
a) Ctrl+End
b) End
c) Alt+End
d) Tab
132. _______ key is pressed to move the cursor to the top of the document.
a) Ctrl+Home
b) Home
c) Alt+Home
d) Page Up
133. _______ key is pressed to move the cursor one word to the left
a) Ctrl +
b) Left
c)
d)
134. ______key deletes the character before the cursor.
a) Ctrl
b) Delete
c) Shift
d) Backspace
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135. ______key deletes the character after the cursor.
a) Ctrl
b) Delete
c) Shift
d) Backspace
136. If we are in ______mode, we can insert new text by simply typing it.
a) Delete
b) type
c) insert
d) overwrite
137. If we are in ______mode, the text you enter will overwrite the existing text.
a) Delete
b) type
c) insert
d) overwrite
138. Pressing_____ key will take you to either insert or overwrite mode.
a) Alt
b) Insert
c) Delete
d) Tab
139. To close WordPad, select _______from the File menu
a) End
b) Open
c) Exit
d) Close
140. The _________ on the taskbar allow you to switch between Applications
a) Pointers
b) buttons
c) Menus
d) Icons
141. The Window that we are currently using is highlighted and it is called _____ Window.
a) Active
b) Home
c) Action
d) First
142. Windows uses a temporary storage location called ______ to store data being moved or copied
a) Cookie
b) Memory
c) Buffer
d) Clipboard
143. _______removes the data from the source location and places them in the destination location
a) Copying
b) Moving
c) Linking
d) Embedding
144. ________ leaves the source data untouched and makes a new copy in the destination location.
a) Copying
b) Moving
c) Linking
d) Embedding
145. In Paint ______tool is used to mark the picture to be copied or moved.
a) Brush
b) Magnifier
c) Select
d) Pencil
146. To copy the picture, click on the _____ menu and select ______
a) Edit, Copy
b) Edit, Cut
c) File, Copy
d) File, Cut
147. Keyboard short cut for copying the text is _______
a) Ctrl + X
b) Ctrl + C
c) Ctrl + V
d) Alt + C
148. Keyboard short cut for moving the text or picture is _______
a) Ctrl + X
b) Ctrl + C
c) Ctrl + V
d) Ctrl + B
149. Keyboard short cut for paste the text or picture is _______
a) Ctrl + X
b) Ctrl + C
c) Ctrl + V
d) Alt + V
150. We can store 24 different items in the _______
a) ClipText
b) ClipBook
c) ClipBoard
d) ClipArt
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TWO MARKS QUESTIONS AND ANSWERS

1. Write Short notes on Windows XP.
Windows XP Professional is a user-friendly operating system designed for popular
use. The most important advantage of using Windows is its GUI(Graphical User Interface).
Windows XP Professional combines all the positive aspects of its Microsoft predecessors.
2. What are the advantages of Windows XP?
 Windows XP Professional is a user-friendly operating system
 It uses Graphical User Interface(GUI)
 It is a multi-user operating system
 It provides the facility to work multiple applications at a time
 It is designed to satisfy the demands of business community.
3. What are interfaces?
Interface is a virtual connection between two entities.
Examples:
 T.V. Remote is an interface which connects a user and a T.V.
 Operating System is an interface which connects a user and a Computer
4. Define CLI.
Command Line Interface(CLI) is a kind of interface. It consists of cryptic commands
and we have to type them without mistakes. Some operating Systems are also case sensitive.
A simple spelling mistake or missed space will result in an error. Example: MS-DOS
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5. What is a Mouse?
The mouse is an input device that you move on a flat surface (usually a mouse pad.).
When we move the mouse, a pointer moves on the screen. This pointer, called the Mouse
Pointer, is used to point to things on the screen. The mouse has either two or three buttons
on the top. The left button is the most often used.
6. What is context sensitive menu?
If we right click on an item, we will be provided with a context sensitive menu.
Context sensitive menu is also called short-cut menu. The context sensitive menu provides
almost all the facilities offered by menu as well as toolbars.
7. What is Logging off?
Logging off is the process of closing the desktop and returning to the Windows Log In
screen.
8. What are the two ways to start an application in Windows XP?
(i) Using icons on the desktop
(ii) Using the Start menu
9. What is a window?
When we start an application, it occupies a rectangular area on the desktop. This
rectangular area is called a window. We can have several windows on our desktop at the
same time.
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10. How do you change the size of a window?
 Every window has a Border that can be used to change its size.
 Point to the window border with the mouse.
 The mouse pointer changes into a double-headed arrow.
 Click and drag this arrow to increase or decrease the size of window
11. How the search results pane is divided in the Help and Support Center Window?
The Search Result pane is divided into:
i) Suggested Topics
ii) Full Text Search Matches
iii) Microsoft knowledge Base
12. What are the different ways to arrange the windows?
i) Cascade Windows
ii) Tile Windows Horizontally
iii) Tile Windows Vertically
13. What is Wallpaper?
Wallpaper is the background display that appears on your desktop. We can choose from
several standard Wallpapers that are available as part of Windows XP.
14. What is Screen Saver?
Screen Savers are constantly moving images that appears when the computer has been idle for
sometime
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15. Why we use Screen Saver?
In old monitors, if you left the images on the screen unchanged for long, the characters
would burn-in, leaving a permanent impression on the screens. To avoid these Screen Savers
were used.
16. How can you customize the desktop?
We can change the appearance of the desktop by changing the background, adding icons,
moving icons, moving and resizing the taskbar and so on. We can also add Screen Savers.
17. What are the two different types of files?
All the information in Windows are stored as Files. They are broadly classified into two types:
i) Application Files
ii) Document Files
18. What are Application files?
Application files are files with which you can do something. Examples: files that allow you
to draw and paint, enter and save text, calculate and play games are application files.
19. What are Document files?
 Document files are files that are created by the user using an application.
 We can start an application by clicking on its icon on the desktop or by using the start
menu.
 At the same time, a button representing the application also appears on the taskbar.
 This button stays on the taskbar as long as the application is active and disappears only
when we close the application.
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20. What is the use of Command Prompt? How do you open Command Prompt? (or)
Where is MS-DOS Prompt available? How do you use it ?
 Command Prompt option on the start menu allows you to use MS-DOS commands and
run DOS-based programs.
 To open Command Prompt window, Select Start  All ProgramsAccessories
Command Prompt.
 The window displays the familiar C:\> prompt. We can use any DOS command here

21. What is a Cursor?
A small vertical blinking line appears at the top left corner of the work area. This is the Cursor.
Cursor indicates our current position on the screen.

22. Define Word Wrap.
WordPad automatically moves the cursor to the beginning of the next line. This feature is
called as Word wrap.
23. What is the Clipboard? How is it used?
 The Clipboard is a temporary storage in Windows for data being copied or Moved.
 We can use the clipboard to store any kind of data.
 The information to be transferred is first copied from the source application to the
Clipboard and from there to the destination application.
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24. What is the difference between copying and moving data?

Copying
Moving
Copying leaves the source data
Moving removes the data from the source
.
untouched and makes a new copy in thelocation and places them in the destination
destination location
location

25. What is Digit grouping?
We have selected Digit grouping under View menu, the numbers are separated by
comma following the European convention. The numbers that appear to the left of decimal
places are separated by comma for every three digits starting from the right. The leading
comma (if any) is suppressed.
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THREE MARKS QUESTIONS AND ANSWERS

1. What are the steps to use the keyboard to do the work of mouse?
(i) Click the Start button
(ii) Select the Control Panel in the menu and click it.
(iii) Choose the Accessibility Options icon and click on it.
(iv) It opens a screen, click on Accessibility Option under pick a Control Panel icon.
(v) Open the Mouse tab.
(vi) Activate use MouseKeys check box
2. List the Equivalent keys in the keyboard for mouse actions.
Key Equivalent
5
+
/
*
Insert
Delete

Equivalent Mouse Action
Click
Double-click
Select the left mouse button
Select both mouse buttons
Select the right mouse button
Lock the selected button
Release the selected button
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3. What are the steps to log off the computer?
(i) Save all your unsaved documents
(ii) Click the Start button (or press Winkey or Ctrl + Esc)
(iii) Click the Log off button (or press L or l key). Log Off is at the bottom of the Start
menu.
(iv) You will be shown Log off Windows. Click Log off button ( or press L or l key )

4. What is Shut down? Why should you shut down your computer properly?
Shut down is the process of closing the desktop and Turn off (Switch off) the computer. We
should shut down the computer properly. Simply turning the power off with the power
switch can cause serious file system damage. While the system is on, files are in use even if
you are not doing anything.
5. What are the steps to shut down the computer?
(i) Save all your unsaved documents
(ii) Click the Start button.
(iii) Click Turn Off Computer button ( or press U or u key).
(iv) You will be Shown Turn Off Computer Window with three options, Turn off, Restart,
Cancel
(v) To shut down the computer click Turn Off button ( or press U or u key ).
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6. What is desktop? What are the things you see on the desktop?
The opening screen of Windows XP is called the Desktop. In Windows XP, the basic
working platform is the Desktop. The desktop has several Icons. Each icon has a label telling
us the name of the application. Examples: My Computer, My Documents, Recycle Bin. The
desktop also contains the Taskbar at the bottom

7. Write short notes on Task bar
 The taskbar is usually a narrow strip, present at the bottom of the screen.
 On the left, it has the Start button.
 When we click on the Start button, the Start menu appears on the left side of the
screen.
 Using the Start menu, you can start any application that you have currently installed.
 Next to the Start button is the Quick Launch Toolbar.
 The quick launch toolbar which contains icons that allow you to select some
commonly used Internet-related applications.
 On the extreme right is the Systems Tray that contains the Clock and icons for other
utilities
 The empty space between the Quick Launch Toolbar and the Systems Tray is used to
display buttons for the applications currently being used.
8. Write short notes on Start Menu.
The Start menu acts as a launch pad for Windows XP. Using this menu, we can start
applications, change the settings of our computer, find files and get help. The Start menu
appears when we click on the Start button on the taskbar.
Two different Start menus:
i) Usual Start menu
ii) Classic Start menu
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9. What are the buttons available in the navigation bar of Help Window?
Back: This is the first button in the navigation bar from left, clicking Back button will take
you to the previous page.
Forward: This is the second button in the navigation bar. We move forward by clicking the
Forward Button.
Home: This is the third button from left in the navigation bar. If we want to return to the home
page, click on the Home button.
History: This stores a list of help pages you have visited recently, in the left pane.
Support: It provides the other forms of technical supports available from Microsoft
Options: This button is helpful in customizing the Help and Support Center.
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10. How do you change the Wallpaper?
 Right-click anywhere in the blank area of the desktop.
 Click on Properties. The Display Properties dialog box appears.
 Select Desktop tab
 Browse through the list of wallpapers and click on the one you want
 Click on Apply and then on OK.

11. What are the steps to use a Screen Saver?
1. To use a screen saver, click on Screen Saver tab in the Display Properties dialog box.
2. Click on the drop-down list box just below the Screen Saver prompt.
3. A list of available screen savers appears Select one.
4. In the Wait text box, we can specify the number of minutes the computer should wait
before displaying the screen saver.
5. Click on Apply and then on OK.
12. How does the computer display the correct time? How can you change time?
 Windows has an in-built clock displayed on the taskbar used to display the Date and
Time.
 To change the date or the time, double-click on the clock on the taskbar.
 The Date and Time Properties dialog box appears on the screen.
 Click on the Date & Time tab.
 Click on the Calendar to change the Month and Year.
 To change the time, click on the digital clock seen on the right.
 Click on OK after you finish
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13. What is WordPad? How do you start WordPad?
 WordPad is a simple word processor that comes along with Windows.
 A Word processor is a program that allows us to type and store text.
 To start WordPad, click on Start  All ProgramsAccessoriesWordPad.
 WordPad window has a title bar, menu bar, toolbar, work area and a status bar

14. Where is the Calculator available? How do you use it? Explain briefly.
 The Calculator is a useful application in Windows used to perform mathematical and
scientific calculations.
 To start the Calculator, select StartAll ProgramsAccessoriesCalculator
 The Calculator can be used in one of the two modes: Standard mode or Scientific
mode
 We can use the keyboard and the mouse to enter numbers and operators.
 If we are using the mouse, click on the number and operator buttons.
 The numbers that we have entered and the results will be displayed in the display bar
just below the menu bar.
 To use the Calculator in the Scientific mode, click on the View menu and select
Scientific.
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15. How start multiple applications?
 Starting multiple applications is very simple.
 First, start one application.
 The application appears on the screen in a window.
 At the same time, a button with the name of the application appears on the taskbar.
 Now, start the second application.
 The window of the second application appears on the screen overlapping
the first window
 The button of the second application appears on the taskbar
 The title bar of the first application and its button on the taskbar become dim.

16. How do you switch between multiple applications?
 The buttons on the taskbar are used to switch between the different applications.
 The button of the application you are currently using is highlighted and its window is
called the Active Window.
 To switch to another application, click on any part of that application’s window that is
visible.

17. How do you copy and move the data?
Copying data:
 Select the data or picture and
 Click on the Edit menu and select Copy or press Ctrl+C
 Move the mouse pointer to the desired location
 Click on the Edit menu and select Paste or press Ctrl+V
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Moving data:
 Select the data and picture.
 Click on the Edit menu and select Cut or press Ctrl+X
 Move the mouse pointer to the desired location
 Click on the Edit menu and select Paste or press Ctrl+V
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FIVE MARKS QUESTIONS AND ANSWERS

1. Explain the Evolution of the Windows Operating System.
The Apple introduced the concept of Windows but Microsoft popularised the Windows concept.
Windows 3.0
 Windows 3.0 is the first version of Windows Operating System.
 Windows came with file management utilities and other system tools.
Windows 3.1
 Windows 3.0 was followed by Windows 3.1
 Windows 3.1 used a window called Program Manager to launch applications.
Windows 3.11
 Microsoft introduced Windows 3.11 for workgroups.
 Windows 3.11 could be used on a LAN-based networking environment.
Windows 95
 Windows 95 was a complete operating system
 In Windows 95, the Program Manager of Windows 3.1 was hidden from the user.
 This was replaced by new ways of starting applications and opening documents.
 Windows 95 gave better facilities to manage application windows, new context-sensitive
short-cut menus, improved networking features and so on.
Windows 98
 Windows 98 came after Windows 95.
 Windows 98 offered many new utilities and support of the latest hardware technologies
 It also provided several features and utilities that allowed easy access to the internet.
Windows NT(New Technology)
 Microsoft produced Windows NT independent of 9x(95 or 98) versions.
 Windows NT family produced Windows NT versions 3.5,3.51,4
 Each of them came in a workstation and a server version.
Windows Me
 Windows Me (Millennium edition) provided stability than previous versions of Windows
9x.
Windows 2000
 Windows 2000 professional increased the compatibility of its parent(Windows NT).
Windows XP
 Windows XP Professional is a user-friendly operating system designed for popular use.
 The most important advantage of using Windows is its GUI(Graphical User Interface).
 Windows XP Professional combines all the positive aspects of its Microsoft predecessors.
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********
2. Explain the different mouse actions that you are familiar with.
i) Move:
 Moving the mouse is simply dragging the mouse on the mouse pad (without touching
the buttons)
 So that the mouse pointer moves in the direction we want.
 This action allows us to point to things on the screen.
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ii) Click:
 Clicking is used to select objects on the Windows screen.
 To click, press the left button of the mouse once and release the button immediately.
iii) Double-click:
 Double-click is most often used to start applications.
 To double-click, press the left button of the mouse twice in quick
iv) Click and drag:
 This mouse action is used to move an object from one place to another.
 When you click and drag an object, the object moves along with the mouse pointer.
 To click and drag, hold the left button of the mouse down and move the mouse to the
place wherever you want.
v) Right click:
 If we right click on an item, we will be provided with a context sensitive menu
 The context sensitive menu provides almost all the facilities offered by menu as well as
toolbars.
************
3. Explain how the Keyboard keys to do the work of mouse actions. (Or)
Explain how do you Move the mouse pointer using the Keyboard
To double-click an object:
 Use the arrow keys to move the pointer over the object
 Press the slash key (/) to select the left mouse button
 Press the plus sign (+) to double-click.
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To right-click an object:
 Use the arrow keys to move the pointer over the object
 Press the minus sign (-) to select the right mouse button, and press 5.
To drag-and-drop an object:
 Use the arrow keys to move the pointer over the object
 Press the slash key (/) to select the left mouse button
 Press Insert to lock the button,
 Use the arrow keys to move the object to its desired destination
 Press Delete to release the button and drop the object.
To click an object:
 Use the arrow keys to move the pointer over the object
 Press the slash key (/) to select the left mouse button and press 5 to click.
To right-drag-and-drop an object:
 Use the arrow keys to move the pointer over the object
 Press the minus sign (-) to select the right mouse button
 Press Insert to lock button
 Use the arrow keys to move the object to its destination
 Then press Delete to release the button to drop the object, and display the context menu.
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4. Describe the different parts of a Window.
 At the top of each window is the Title Bar. The title bar tells the name of the
application.
 Below the title bar is the Menu Bar. This displays the different menus available to us.
 One or more Toolbars appear below the menu bar. Toolbars consist of icons
representing shortcuts for the most frequently used commands.
 The Title Bar also contains three of the four Sizing buttons, at the top of the right
corner.
Minimize Button:
The minimize button is used to reduce the size of the window to a button on
the taskbar.
Maximize Button:
Clicking on Maximize button enlarges the window to fill the entire desktop
Restore Button:
Restore button is used to restore the window to its original size
Close Button:
Close button is used to close a window. Closing a window will remove its
contents from memory and screen.
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5. Explain the different kinds of dialog boxes and controls used in Windows.
Windows XP GUI uses dialog boxes to display the information and allows us to either type or
select from a list of choices. Some of the controls used in dialog boxes are:
Text Boxes:
 Text boxes are used to allow the user to enter some data.
 Every text box has a prompt or label that tells us what should be entered in that box.
List Boxes:
 These boxes display a list of choices.
 We can select the one we want by simply clicking on it.
Drop-down List Boxes:
 These are list boxes which have a small black inverted triangle at one end.
 When we click on this triangle, a list of options drops down in front of us.
 We can select an item from this list by clicking on it.
Radio Buttons:
 Radio buttons are used to display multiple options.
 A black dot appears at the center of the circle to indicate a selected option.
 We can select only one of the Radio buttons.
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Check Boxes:
 Check boxes are used to enable or disable options.
 Clicking on a square enables the option and clicking on it again disables it.
 A tick mark in this square indicates that the option is enabled
 We can select any number of check boxes
Buttons:
 The OK and Cancel buttons are the most frequently used buttons in Windows XP.
 When you click on a button, the related command is carried out.
 Clicking on OK button will make Windows to accept our choices
 Clicking on Cancel will make Windows ignore the changes
.
Tabs:
 Tabs are used to display different sets of options in dialog boxes.
 Clicking on each tab displays an entirely different set of options.
Sliders :
 Sliders are used to enter a value by physically moving a marker over a slide.
**********
6. What is Control Panel? Describe some of the icons found on the Control Panel.
The Control Panel allows us to install and manage the different hardware components
attached to the computer. Some of the icons found on the Control Panel are:
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Accessibility Option:
This allows us to adjust the computer settings for vision, hearing and mobility deficiency.
Date and Time:
This allows us to set the date, time and the time zone for our computer.
Display :
This allows us to change the appearance of your desktop, such as the background,
screensaver, color, font size and screen resolution.
Fonts:
This allows us to add, change and manage fonts on our computer.
Keyboard:
This allows us to customize our keyboard settings such as the blink rate and character
repeat rate.
Mouse:
This allows us to customize settings such as the button configuration, double click, speed,
mouse pointer and motion speed.
Printers and Faxes:
This allows us to install printer and fax Printer and helps you add new ones.
Regions and Languages
This allows us to customize setting for the display of languages, numbers times and dates.
User Accounts:
This allows us to change user account setting and password to people who share this
computer
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7. How do you Customizing Windows XP?
i) Customizing the Taskbar:
 Point the mouse pointer to any empty area on the taskbar.
 Click and drag the taskbar to wherever you want it to be.
 To change the size of the taskbar, Point to the edge of the taskbar.
 The mouse pointer will change into a double-headed arrow.
 Click and drag the mouse to increase or decrease the size of the Taskbar
ii) Changing the Taskbar Settings:
 Right click on the empty area of the taskbar.
 From short cut menu, by selecting Toolbars, you can add or delete tools.
iii) Arranging Windows
 We can arrange the windows with any one of the following
a) Cascade Windows
b) Tile Windows Horizontally
c) Tile Windows Vertically
iv) Changing the Wallpaper:
 Right-click anywhere in the blank area of the desktop.
 Click on Properties. The Display Properties dialog box appears.
 Select Desktop tab
 Browse through the list of wallpapers and click on the one you want
 Click on Apply and then on OK.

www.Padasalai.Net

v) Using Screen Savers
 To use a screen saver, click on Screen Saver tab in the Display Properties dialog box.
 Click on the drop-down list box just below the Screen Saver prompt.
 A list of available screen savers appears Select one.
 In the Wait text box, we can specify the number of minutes the computer should wait
before displaying the screen saver.
 Click on Apply and then on OK.
**************

8. What is Paint? Describe briefly the different parts of the Paint window.
 Paint is an application that lets you draw and color pictures. To start Paint, click on
StartAll Programs Accessories Paint
 The paint window appears on the screen.
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Paint window also has a title bar with sizing buttons, a menu bar and a status bar.
It also has a Toolbar and a Colour Box.
The Toolbar has various tools that you can use to draw and colour.
The Colour Box contains the colours that you can use.
To close Paint click on the Close button on the title bar or clicking on the File menu and
selecting Exit (or Alt+F4 keys).
Tools available in the Tool bar
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9. List some useful Editing keys to move the cursor through the text.
Key



Place it moves the Cursor
One character to the right
One character to the left
Up one line
Down one line

Home
End
Ctrl + Home
Ctrl + End
Page Up
Page Down
Ctrl + 
Ctrl + 

Beginning of the line
Top of document
End of line
End of document
Up a page (or screen)
Down a page (or screen)
One word to the left
One word to the right

Ctrl +

Up one paragraph

Ctrl +

Down one paragraph

Ctrl + Page Up
Ctrl + Page Down

To top of previous page
To top of next page
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10. Describe briefly how to edit text entered in WordPad.
 A small vertical blinking line appears at the top left corner of the work area. This is the
Cursor.
 It indicates your current position on the screen.
 Move the cursor to the place where you want to edit, using the arrow keys on the
keyboard.
 We can also use the mouse to move the cursor.
 Once you have moved the cursor, you can delete text using the Backspace and Delete
keys on the keyboard.
 Backspace key deletes the character before the cursor
 Delete key deletes the character after the cursor.
 If you are in insert mode, we can insert new text by simply typing it.
 If you are in overwrite mode the text you enter will overwrite the existing text.
 Pressing Insert key will take you to either of the modes.
 To close WordPad, click on the Close button on the title bar or select Exit from the File
menu.
***************
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